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Welcome to PaperPort

Welcome to the Nuance® PaperPort® Getting Started Guide. It is supplied as a 
PDF file, suitable for use with screen readers. If you print it to paper, we 
recommend double-sided printing with two pages per sheet.

PaperPort provides the easiest way to turn paper into organized digital 
documents that everybody in an office can quickly find and use. 

PaperPort works with scanners, multifunction printers, and networked digital 
copiers to turn paper documents into digital documents. It then helps you to 
manage them along with all other electronic documents in one convenient and 
easy-to-use filing system. 

PaperPort’s large, clear item thumbnails allow you to visually organize, 
retrieve and use your scanned documents, including Word files, spreadsheets, 
PDF files and even digital photos. PaperPort’s Scanner Enhancement 
Technology tools ensure that scanned documents will look great while the 
annotation tools let you add notes and highlights to any scanned image.

Accompanying programs
PaperPort 14 SE (Special Edition) includes a PaperPort image printer, a 
Scanner Setup Wizard, an ImageViewer application (for viewing and working 
with page images in a window separate from PaperPort) and PDF Viewer Plus 
(for viewing and working with PDF files).

Added components are the Nuance Cloud Connector for accessing cloud sites 
and a MAX to PDF Converter.

Installing PaperPort 
You can install PaperPort from a CD, a DVD, or from the Internet. The 
installation program provides easy step-by-step instructions. Follow the 
guidance on each screen to install the software. Installation and un-installation 
require administrator rights. 
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PaperPort installation comprises four elements that are installed in a single 
process:

• PaperPort program (includes ImageViewer, MAX to PDF Converter, an 
Evernote connector and the Scanning Wizard)

• PDF Viewer Plus 

• The PaperPort image printer 

• The Nuance Cloud Connector (optional install)

PDF Viewer Plus is not installed if the top-line Nuance product PDF Converter 
Professional is detected on the computer (version 6 or above) because it provides 
all the functionality of PDF Viewer Plus, and much more additionally.

 

Avoid collisions between parallel installations of PaperPort.

To install PaperPort and its key components:

   1. Click Autorun.exe.

2. Select an installation language.

3. Accept or change the program location.

In certain cases, you may be required to enter a serial number.

If PDF Viewer Plus is to be installed, the following checkmarks appear:

Set Nuance PDF as your default viewer for Windows and Internet Explorer

This sets PDF Viewer Plus as your system default PDF viewer. PDF files on the 
PaperPort desktop are by default opened in a Nuance PDF product. If you select 
this option, PDF files that are double-clicked anywhere on your system will open 
in PDF Viewer Plus.

Install the Nuance Cloud Connector

This optional application provides convenient file transfer to and from the most 
popular web-based storage sites. By default it is not installed.
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Autorun then starts the installer. It offers a Complete or a Custom 
installation. Choose Custom only if you want to add your own folders to the 
supplied PaperPort folders during installation. You can add folders later (see 
page 24). 

Registration

Registration may be offered after installation. This enables you to take full 
advantage of Nuance® product support and to receive notifications of product 
updates. To update your registration information, you can always go to the 
Nuance web site at http://www.nuance.com.

Learning PaperPort

This guide introduces you to PaperPort and shows you how PaperPort can 
help you manage your information. 

Additional sources of information to help you learn how to use PaperPort 
include a comprehensive Help system, the How-to-Guides, Release Notes, 
and the Nuance web site. Access these from the Help ribbon.

Using this Guide

This guide is written with the assumption that you know how to work in the 
Microsoft® Windows® environment. Refer to your Windows documentation 
if you have questions about how to use dialog boxes, menu commands, scroll 
bars, drag and drop functionality, shortcut menus, and so on.

Using Help 

The PaperPort Help includes detailed information on features, settings, and 
procedures. Help is available from the PaperPort Help ribbon. Additional 
technical support, including technical notes, software updates, product 
information and product support issues and more is available also from the 
PaperPort Help ribbon. PDF Viewer Plus, and also PDF Converter Professional, 
have their own Help systems that include guidance on PDF creation.
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Using release notes

PaperPort Release Notes provide important information about this release of 
the program. This document is included on the installation CD or DVD, and 
can be accessed from the PaperPort Help ribbon, and as a sample document on 
the PaperPort desktop.

Technical Support

Before turning to Technical Support, check the user documentation and 
review the Release Notes. A self-service 24-hour Knowledge Base is 
available at http://www.nuance.com or http://nuance.custhelp.com. 
Personalized Technical Support for Special Editions of PaperPort is arranged 
through the dealers who supplied this program to you. Contact your dealer for 
more information.

Minimum System Requirements
•  Minimum hardware requirements:

― Intel PentiumTM compatible, or higher processor

― 1 GB of memory (RAM)

― 800 MB free hard disk space for the application files and installation

― 30 MB for the Nuance Cloud Connector 

― 1024 x 768 resolution display with 16-bit (High Color) or higher

•  Supported operating systems:

― Windows XP 32-bit with SP3 or above

― Windows Vista 32-bit and 64-bit with SP2 or above

― Windows 7 in 32-bit and 64-bit versions

― Windows 8 in 32-bit and 64-bit versions

•  Supported web browsers: 

― Windows Internet Explorer 7 or above

― Mozilla Firefox 3.6 or above
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― Google Chrome 4 or above

A CD or DVD drive or web access is needed for installation. An Internet 
connection and web access are necessary for online activation, registration, 
technical support, and live updates. 

 

Performance and speed will be enhanced if your computer’s processor, 
memory, and available disk space exceed minimum requirements. This is 
especially true when handling very large color image and PDF files. 

What’s new in PaperPort 14 SE?

PaperPort 14 SE includes a number of valuable new features to help you manage 
your documents: 

Nuance Cloud Connector 

This service connects your computer and PaperPort with other popular web-
based storage sites, including Microsoft Live SkyDriveTM, GoogleDocsTM, 
Box.netTM, multiple FTP sites, and many more. The Connector can integrate 
directly with Microsoft Windows providing easy drag-and-drop access directly 
to cloud services. The Nuance Cloud Connector is also upgradeable to a more 
feature-rich version of the product called Gladinet Cloud Desktop Pro. This 
enhanced version adds additional functionality for using cloud services with 
automatic backup and file synchronization.

Evernote Connector

The Send To bar offers a link to the Evernote web storage facility, so that 
PaperPort items can be transferred to this Cloud service.

New SET tools

Manual despeckling with a wide choice of algorithms yield better black-and-
while images for optimum OCR results. 
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New edge cleaning tools include automated punch-hole removal, auto-cropping 
pages, and border cleaning.

Key features

High-quality PDF performance

PDF files can be opened quickly and displayed in PDF Viewer Plus, a Nuance 
PDF handling application that is fully compatible with all leading PDF creation 
products. PDF Viewer Plus opens files faster than the general-purpose 
ImageViewer, reducing memory requirements and permitting smaller file sizes. 
The viewer optimizes the rendering resolution for each element on the page 
yielding a cleaner display and optimum print resolution. 

PDF Viewer Plus provides annotations and dynamic or transparent stamps. 
Images within a PDF document processed by PDF Viewer Plus can be sent to the 
ImageViewer to be enhanced using SET tools, with the modified image returned 
to the PDF. 

Fill and e-mail PDF forms and create new ones from scratch. 

Searchable PDF files are available through Scanner Profiles, through a right-
click Save As operation on the PaperPort Desktop, or directly in PDF Viewer 
Plus.  This makes the content of your scanned paper documents or image files 
accessible to search engines such as Windows Desktop SearchTM or GoogleTM.

Accurate OCR

Language settings can be applied to Optical Character Recognition to increase 
accuracy in all supported languages.

Digital camera input

It is possible to take a picture of a document with a digital camera and accurately 
convert it into a text document. This is done by applying special 3D-deskewing 
algorithms that flatten page images and correct distortions to increase the 
accuracy of the resulting text document.
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Making PaperPort more reliable

Sometimes PDF files may become corrupted so that they can no longer be 
opened. In these cases PaperPort may not be able to generate a desktop 
thumbnail and this may prevent PaperPort from launching properly.  

A utility program  CheckPPFolders.exe is supplied in the PaperPort program 
folder. Run this program to identify and remove any corrupt files so that 
PaperPort will work properly.

PaperPort Special Editions are supplied to selected scanner manufacturers and other 
resellers. The feature set in these editions may vary, in line with each vendor’s requirements.
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Getting to Know PaperPort
This section introduces you to the different parts of PaperPort. Refer to 
the PaperPort Help for detailed information about all these topics.

The PaperPort desktop
The PaperPort desktop appears with the Folders pane when you first 
start the program. It displays the documents in the chosen folder as 
thumbnails and provides tools to manage them. PaperPort offers all the 
tools necessary to organize, find, and use documents and images. 
Choose Options from the Desktop ribbon and go to the Desktop panel 
to choose a color scheme for the desktop and its elements.

The Function pane can present:

• Folders
• Scan Settings 
• Thumbnails
• All-in-One Search
• Properties 

Image item  
thumbnail

Text i tem  
thumbnail

Access to  
other pages in 
this multi-page 
item

Desktop  
showing item 
thumbnails

Send To bar

Ribbons with command buttons

Function Pane  
showing folders
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The PaperPort Ribbon
PaperPort 14 and ImageViewer have a 
modernized tab and ribbon interface. 
The main elements are:

1.  The PaperPort button

2.  Quick Access Toolbar 
     (see page 20)

3.  Tab

4.  Ribbon associated with the tab

5.  Group inside the ribbon

6.  Button within the group

7.  A button drop-down list.  

PaperPort items
The documents and photographs you acquire in PaperPort are called 
items. There are two types of items: image items and text items.

• Image items are scanned documents, photographs, drawings and 
other digital items in an image format, such as PDF Image, PDF 
Searchable, JPEG, TIFF, or PaperPort Image files (these MAX files 
are read-only). They can be scanned, copied or imported into the 
PaperPort desktop. 

• Text items are documents that contain editable text, such as Word 
(.doc), HTML, and Excel files, and are created by word processing 
and other text-based applications. Normal PDF files are considered 
to be text items. 

Image items when double-clicked open by default in Image View that 
offers many image-handling tools, including the SET tools. Go to Options 
> Desktop to change this behavior. You can choose ImageViewer; this 
offers the same functionality as Image View, but in a separate window so 
you can still view the PaperPort desktop as you edit the chosen item. This 
is specially useful in a dual-screen environment. You can also choose to 
open the item in the application associated with the file type.
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You can use any flavor of PDF file: PDF Image, PDF Searchable, and 
PDF Formatted Text and Graphics (PDF Normal) with PaperPort. PDF 
files by default open in PDF Viewer Plus or (if available) PDF 
Converter Professional. These Nuance programs are optimized for 
handling, annotating and editing PDF files. Go to Options > Desktop to 
change this behavior. You can open PDF Image or PDF Searchable files 
in ImageViewer in order to use the SET tools to improve the quality of 
these items.

You can quickly send an item to another program without leaving the 
PaperPort program. Just drag an item onto the link icon in the Send To 
bar at the bottom of the desktop. PaperPort supports a wide variety of 
programs including word processing, spreadsheet, fax, Internet e-mail, 
graphics, optical character recognition (OCR), and online services 
programs. 

The MAX to PDF converter
MAX files have long been the proprietary PaperPort image item format. 
This functionality has now been taken over by the universal PDF file type. 
In PaperPort 14, MAX files retain limited functionality: they can be 
viewed page-by-page but cannot be annotated, stacked or otherwise edited. 
Metadata (author, subject, keywords, and so on) cannot be added in 
PaperPort 14, only already existing texts remain. In other words, MAX 
files are now read-only and can be exported to some other programs (for 
instance to mailing applications, or to OmniPage for OCR).

Because of these changes, Nuance offers a Wizard-like program to convert 
MAX files to PDF. Find the MAX to PDF converter in the PaperPort sub-
menu in the Windows Start menu. It can create PDF Image or PDF 
Searchable files by running OCR on text in the MAX file. The converter 
allows annotations to be transferred to the resulting PDF. Language 
choices are available separately for the MAX file content and for its 
annotations. The converter can automatically find all MAX files within 
your PaperPort folders. 
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The Folders pane
The Folders pane presents a hierarchical view of your 
PaperPort folders, similar to the view you see in 
Windows Explorer. Use the Folder Tools to access its 
commands quickly.

PaperPort installs a PaperPort folder named My PaperPort Documents 
into your My Documents folder. If you are using a multi-user system, 
each user has their own My PaperPort Documents folder.

The My PaperPort Documents folder contains several subfolders 
whose names – such as Articles, Business Cards, Photographs, and 
Receipts – illustrate the different ways you can organize your items in 
PaperPort. 

The Samples folder contains sample documents and photographs to 
help you get started using PaperPort. 

This Getting Started Guide is placed in the Samples folder as a read-only 
PDF file. We recommend you copy the item and remove the read-only 
property from the copy if you want a text file (PDF Normal) for 
experimentation.

Choose  Folders to view  the Folders pane to view the pre-supplied 
folders. Select a folder, right-click and choose Create New folder to add 
an empty subfolder with a name and color you choose. You can use the 
Folder Manager to add existing folders and sub-folders from your file 
system. This lets you set up a different view of folders than exists on your 
computer – tailoring it to work you will do via PaperPort. 

Choose   Folder Manager on the Tools ribbon or right-click in the 
Folders pane and choose Folder Manager. Click Add and browse to an 
existing folder or sub-folder. They are added as top-level folders to the 
PaperPort desktop along with their sub-folders and content. For instance, if 
you chose C:\MyReports\Fourth Quarter, this appears in 
PaperPort as Fourth Quarter on C. To later see the full path of an added 
folder, right-click and choose Properties. You can also right-click on a 
folder to change folder color. 
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The Folder Manager lets you rename, remove and reorder the top-level 
folders it manages. This does not affect the names, locations or existence 
of those mapped folders in your computer. Sub-folders that you rename or 
reorder which were not added using the Folder Manager are really 
renamed or moved in your system. 

To show or hide the Folders pane, click the Folders button on the Desktop 
ribbon. With the desktop split, Folders panes can be displayed for each 
Workspace.

PaperPort item thumbnails

There are two kinds of thumbnails in PaperPort: item 
and page thumbnails. Each item thumbnail is a small, 
graphic representation of your document or photo. Page 
thumbnails show pages of image items and PDF files in 
the Page Thumbnails pane both on your PaperPort 
desktop and in the ImageViewer.

One quick way to locate your PaperPort items is to visually browse 
through the item thumbnails on your PaperPort desktop. Thumbnails 
show you what is in a document without having to open it. Thumbnails 
also give you the ability to scroll through the pages of a document 
without opening it. PaperPort shows large, clear thumbnails of all your 
documents and photos, including:

• Scanned pages and photos

• Photos from your digital camera

• Image files in formats such as BMP, TIFF, JPEG, GIF, and MAX 
(read-only)

• Microsoft Word, PowerPoint®, Excel®, Word PerfectTM , and other 
documents created in popular software programs

• PDF documents

• PDF Image items

• HTML documents 
PaperPort Getting Started Guide           16



Each item thumbnail appears with an icon that identifies the program in 
which it was created or is currently associated. This makes it easy and 
convenient to quickly see and find all the different types of items on 
your computer.

Click on a thumbnail to see image attributes: 

  indicates that the Read-only attribute is set for that item. 

  indicates that the image has annotations. 

  indicates that the PDF file has searchable text. 

Multi-page image items (TIFF, DCX, PDF, etc.) show  to let you 

scroll through the pages even with the Page Thumbnails pane closed.

Before you can work with an item, you must first select its thumbnail on 
the PaperPort desktop. A red border appears around an item to indicate 
that it is selected. Multiple selections are possible. While working with 
item thumbnails, you can: 

• Drag a thumbnail to reposition it on the PaperPort desktop.

• Drag a thumbnail to a folder to move the item to that folder.

• Drag a thumbnail to another open Workspace to move the item to 
that open folder.

• Double-click a thumbnail to view the item.

• Press the Ctrl key and double-click a thumbnail to open the item in 
its source program.

• Right-click a thumbnail to display the item’s shortcut menu.

• Drag a thumbnail to the Send To bar to send a copy of the item to 
another program.

Using item thumbnails on the PaperPort desktop, you can also easily 
combine individual PaperPort Image items or PDF Image items into 
multi-page items. This feature is useful as an organizational tool if you 
are using a scanner that can only scan a page as a separate item. 
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If you are not seeing thumbnails, right-click in the Workspace or use the 
Change View button and choose Thumbnails. Other choices are large or 
small icons, a list or a list with details.

PaperPort page thumbnails
The Page Thumbnails pane on the PaperPort desktop and in 
ImageViewer displays thumbnails for multi-page image items. Select a 
multi-page item, then click the Thumbnail button on the Desktop 
ribbon. Page-level operations can be done quickly without having to 
open the files. You can:

• Enlarge or reduce thumbnail size  
(all image items and PDF files of all flavors).

• Copy selected pages to a Workspace as separate PDF files 
(from all non-PDF image items).

• Move selected pages to a Workspace as separate PDF files 
(from all non-PDF image items except read-only MAX files).

• Copy and move pages between documents open in different panes. 
(from all image items except read-only MAX files).

The following operations are available for PDF files, on the PaperPort 
desktop or in PDF Viewer Plus:

• Copy, paste, cut, delete and reorder pages.

• Insert new pages at a certain location in the document.

• Append new pages at the end.

The Page Thumbnail view of a secure PDF is only available by supplying its 
password.
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The Image View window
To view an image item in the Image View window, double-click its 
thumbnail in Desktop view, or choose Open with Image View on the 
Desktop ribbon or from its shortcut menu. By default PDF files appear 
in PDF Viewer Plus, not in Image View. The Image View window 
allows you to take a closer look at your items and to touch up and 
annotate them. You can also enlarge or reduce the view for easy reading. 
Use the SET tools to enhance the current page image. Use the Page 
Thumbnails pane to edit your document at page level.

 

SET tools on the 
Page ribbon

Select 
Area 
button

Page Thumbnails Pane displays one 
thumbnail for each page in the document

Return to Desktop button, by 
default on the Quick Access 
Toolbar  
(also on the View ribbon)

Current page 
displayed in large 
size, ready for 
enhancement or 
annotating
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Customizable Quick Access Toolbar
PaperPort’s buttons are placed on different ribbons according to their 
functionality. You can place frequently used buttons on the Quick 
Access Toolbar in PaperPort and also in ImageViewer. Right-click 
within the ribbons area and choose Customize Quick Access Toolbar.

Set toolbar 
button order

Buttons currently visible 

Choose the ribbon 
whose buttons you 
want to add

Add/remove buttons More available buttons

PDF Viewer Plus
PDF files on the PaperPort desktop when double-clicked appear by 
default in the new PDF Viewer Plus. You can drag other files onto the 
PDF Viewer Plus icon in the Send To bar (see page 39) to have a copy 
converted to PDF and opened in the PDF Viewer. The first page appears 
in the main screen area; a navigator panel on the left shows page 
thumbnails or form controls and a comments panel can be displayed 
along the bottom of the screen. An organizer panel on the right offers 
stamps. The PDF annotation tools are described on page 32. If an image-
only PDF enters the PDF Viewer, the program may offer to make it 
searchable. If not, choose Make Searchable PDF from the Tools menu.

Active PDF forms can be filled in directly in PDF Viewer Plus, as 
described on page 43. PDF files opened from the PaperPort desktop 
return there when you finish editing or annotating them with all the 
updates included. This happens when you save the file or close the 
Viewer, but not if you just switch back to the Desktop.
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Acquiring Items
There are many ways to bring images and documents into PaperPort so 
that you can use PaperPort’s viewing, editing, OCR, and file 
management tools. For example, you can:

• Scan photos, pages, and other images on a scanning device.

• Add folders to PaperPort that already contain images and 
documents.

• Import files from other programs on your computer.

• Download files from web storage sites via Nuance Cloud Connector.

• Print documents from other programs to the PaperPort desktop.

• Drag or cut-and-paste images and documents from Windows 
Explorer, or other programs to the PaperPort desktop.

• Acquire photos from a digital camera.

• Print web pages to PDF files for use in PaperPort.

Scan to the PaperPort desktop

PaperPort is designed to work with TWAIN- and 
WIA-compatible scanners. 

Click the Scan Settings button to display the Scan or 
Get Photo pane. Choose a scan profile. Profiles are 
optimized for typical scanning tasks.

Then choose between using the native interface of the 
scanner or utilizing the new Scanner Settings pane of 
PaperPort for best scanning results. To use the 
interface of the scanner driver, mark the checkbox 
Display scanner dialog box. Leaving it empty will 
put the scanned item onto the active Workspace. 

Turn on the Capture Assistant to add an item name. When the scan is 
complete, you will see your item on the PaperPort desktop. Right-click 
the item, choose Properties, then File Properties and Summary to add 
Item Name to the scanned items.
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When the scan is complete, you will see your item on the PaperPort 
desktop.

If your scanner does not use a TWAIN or WIA device driver, use the program 
that came with your scanner to scan items. Then, copy or move the scanned 
items to PaperPort. Refer to the PaperPort Help for more information about 
scanning.

PaperPort makes it easy to scan pages as separate items or as a multi-page 
item. To scan and collate two-sided pages on your ADF scanner, flip the 
pages when prompted, click Scan Other Side, and PaperPort will 
automatically scan and collate the pages in the correct order.

You can also use your scanner device buttons to scan directly into 
PaperPort. Open the Windows system Control Panel, choose Scanners 
and Cameras, choose an event in the Events tab, and assign PaperPort to 
it. Alternatively, open the Control Panel and in the search box type 
scanners and cameras, and then click Scanners and Cameras.

You can also use a high-speed, networked scanner to scan items to a networked 
folder and then add the folder to PaperPort.

   

Set up a scanner with PaperPort
Before using PaperPort for scanning, your scanner 
should be installed with its own scanner driver software 
and tested for correct functionality. Scanner driver 
software is not included with PaperPort.

Properly installed and correctly functioning scanners 
are immediately available in PaperPort by clicking the 
Select button, and choosing one in the Available 
Scanners dialog.  If you are not satisfied for your scan 
results, you can run the PaperPort Scanner Setup 
Wizard from the Start menu, under the program group 
PaperPort 14.
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Using Scan Profiles
PaperPort comes with scan profiles optimized for typical scanning tasks. 
Choose Black and White, Grayscale or Color Document, Color 
Photograph or Color Searchable PDF Document. 

Each scan profile has a Settings panel with the following tabs:

• Profile: displays the currently used scan profile.

• SET: define what enhancements you would like to run 
automatically.

• Output: set file format and automatically suffixed file names.

• Scan: adjust scan settings: mode, resolution, size, orientation, filter 
color, brightness and contrast

Print to PaperPort

To bring items in from other programs, print them to the PaperPort desktop 
as PDF Image or PDF Searchable. The default is PDF Image; go to 
Desktop > Options > Item to change it. This lets you quickly import 
spreadsheets, pictures, database files, word processing files, and other files 
into PaperPort as PDF items on the PaperPort desktop. This works through 
the File menu (or equivalent) in the source application; choose Print to 
PaperPort or choose Print, then choose PaperPort Image Printer. 

Choose Print in your web browser to create print-formatted views of web 
pages. The printer called PaperPort Image Printer gives you PDF Image 
or PDF Searchable files. 

If you have Nuance PDF Converter Professional or PDF Create, the 
ScanSoft Printer gives you Normal PDF.

In all cases, PaperPort is launched if not running and the PDF file is placed 
on the current desktop.
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Add PaperPort folders

PaperPort provides an easy-to-use filing system for 
organizing your items and sharing them with others. 

In the Folders pane, you can:

                                                                                                       

• Add existing folders on your computer to the Folders pane.

• Create new folders, mapped network drives and folders on external 
attached devices. 

 

Initially, the Folders pane shows a set of folders designed to help you get 
started using PaperPort. You can move or delete these folders whenever 
you prefer. If you choose a custom installation, you can add your own 
folders at that time.

Any time later, you can add folders already on your computer to the 
Folders pane, including network folders and folders on external devices 
attached to your computer. Documents within these folders are then 
available for use within PaperPort.

Refer to the PaperPort Help for more information about adding and 
using PaperPort folders.

Import pictures from your camera

To bring digital photos on the PaperPort desktop, first plug your camera 
in. If your device is displayed as a drive you can start acquiring your 
files. If your camera does not support this kind of operation, and its 
driver is installed properly, its TWAIN or WIA interface will display 
enabling you to import images from it.
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Do not edit the images on your camera in place – not all editing produces the 
desired result first time. Instead, bring your files into PaperPort and use the SET 
tools to enhance them.

Touching Up Images
When you display an image item in the Image 

View window, PaperPort provides several tools 
you can use to adjust or improve your image. 

For example, you can straighten a scanned page, 
lighten an underexposed photograph that is too 
dark, adjust the color in a color picture, remove 

‘dirt spots’ from a document page, clear shadows and spots from page 
edges, or sharpen fuzzy pictures. 

In addition, you can rotate an item, remove stray dots, enhance lines, 
remove red eye, and crop part of an image. 

Some SET Tools are primarily designed for photo, or image 
enhancement, while others (‘shaded’ in the table below) help you 
prepare items containing text for Optical Character Recognition (OCR). 

In the Image View window the Page ribbon contains the SET tools to 
modify the current page. Some of these tools are also available on the 
PaperPort desktop for use with all pages in the selected item. 
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Scanner Enhancement Technology tools

In the following table the availability is shown like this:

P = Image View or ImageViewer (Page ribbon) to change the current page only.
PI = Also on PaperPort desktop (Item ribbon) to change all pages in selected item(s).
PM = Also in PaperPort desktop shortcut menu to change all pages in selected item(s).
PS = Also available in a Scanning Profile to modify all incoming images.

Select Area
(P) 

Use the Select Area tool to select part of an 
image you want to cut, copy, or delete with 
commands on the Page ribbon or shortcut menu. 
Use it to select part of an image for cropping, 
using the Remove Red Eye, Erase Inside or 
Erase Outside tools.

Rotate
(PI/PS)

Click the Rotate tool to rotate the selected page 
or item 90 degrees to the left, right or by 180 
degrees.

Straighten  
an image

Sometimes a document is crooked when 
scanned. When this occurs, you can use the 
Straighten (P) and Auto-Straighten (PI/PS) 
tools to adjust it. Straightening lines of text in a 
black-and-white image file will yield better 
OCR results.

Auto-enhance  
(PI/PS)

The Auto-Enhance feature adjusts the 
brightness and contrast, color, and tint of an 
image or item. PaperPort analyzes the image 
and tries to correct whatever is wrong with it.

Enhance  
an image
(P) 

You can manually adjust your image using the 
Enhance tool. It lets you change brightness, 
contrast, color and tint values and choose the 
best result from nine candidates, as shown on 
page 29.

Sharpen  
an image
(P) 

Select the Sharpen tool to adjust the sharpness 
of a blurry picture or blur a sharp image for 
special effect.
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Remove  
red eye
(P)
 

The Remove Red Eye tool helps you to remove 
the red-eye effect from a selected part of a 
picture. Red Eye may occur when photo-
graphing people or animals in low light or with 
a flash.

Remove  
part of  
an image
 

Use the Selection tool to define the part you want 
to keep and use the Crop tool (P) to remove the 
remainder. Select the Eraser tool (P) to erase an 
image area that you draw over with the pointer.

Resize
(PI)

Resize an image or item and/or change its 
resolution. (Colors can also be converted or 
inverted).

Remove  
stray dots 
(PM)

Scanned images sometimes include dots or 
speckles. The Stray Dots tool automatically finds 
and removes such ‘dirt’ from a page. Use it for 
better OCR results on black-and-white images.

Improve lines 
(PM)

The Improve Lines tool (for black-and-white 
images) darkens lines and connects broken lines 
in a table or form to appear darker and straighter. 
The use of this tool will render better recognition 
results. 

Erase  
outside
(P)

Use this tool to clear shadows and spots from 
page edges to improve OCR performance. There 
is also an Erase Inside tool (P).

Invert colors Use this tool to change the image to inverted 
color values. (PI/PM)

Convert color Use this tool to change color images to grayscale, 
halftone or black-and-white. (PI/PM)

Punch-hole 
removal 

Remove hole marks from page sides, replacing 
them with the background color. (PI/PM/PS)
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Change black and white points to improve image quality by removing the 
dark and overexposed areas. All colors lighter than a chosen white point 
will become white. All colors darker than a chosen new black point are set 
to black. 

A typical use for this is to remove a shaded gray background in a 
document you want to OCR. Select one of the darker gray pixels from the 
background and apply it as the white point. Then the background will 
become white. Changing black and white points for a color photo will 
typically increase its contrast, but may also change color values.

Auto-Crop
 

This tool detects blank areas on page edges and 
automatically crops the pages, leaving margins 
with pixel dimensions you specify. (PI/PM)

Black border 
cleaning

This tool removes scanning shadows from page 
margins. (PI/PM/PS)

Despeckle This tool cleans black-and-white images using a 
chosen despeckling type. (PI/PM/PS)

Set white 
point (P)

Click this tool, then click on a light color in the 
image that will become the white point. For more 
information, see below. 

Set black 
point
(P)

Click this tool, then click on a dark color in the 
image that will become the black point. The 
colors chosen for the new white and black points 
are displayed on the Status bar.

Apply current 
black and 
white  
points

Click this tool to apply the new black and white 
points to the current image (P) or item (I). If the 
result is not acceptable, undo your changes and 
pick new values.
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You can apply new black and white points to individual images, as 
described. You can also apply them as an auto-enhancement to all new 
pages scanned with a given scan profile.

Convert Color choices

      Color       Grayscale          Halftone            Black-and-white

Enhancing Images Manually
Choose Enhance from the Page ribbon in Image View to receive nine 
candidate variants of your picture. Adjust brighness and contrast, color, 
or tint, then double-click the desired image. It is placed in the center and 
becomes the new original. The first original remains and can be reset.
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Edit multiple images
The ability to process items as a group is often referred to as batch 
processing. PaperPort provides batch processing features so that you can 
quickly enhance, modify, or rotate multiple image items in a single 
operation.

Select one or more image items on the desktop, and then, on the Item 
ribbon, choose the desired command. See the Help for more 
information.

Click to finish 
enhancing

Slider for less 
or more

Original image  
(with reset)

Current selection

Choose to modify  
Brightness & Contrast 
Color 
Tint
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Annotating Pages
PaperPort includes a collection of annotation tools that allow you to mark 
up scanned documents with information you would like to keep with that 
document. For a wider offering of PDF annotation tools use the supplied 
Nuance PDF product. 

All other image items must be annotated in Image View or ImageViewer, 
but remember that you can drag any of these files onto the Nuance PDF 
product icon on the Send To bar to have them converted to PDF Image or 
PDF Searchable, ready to be annotated or otherwise edited.

In PDF files annotations are editable, meaning that you can reposition, 
change, remove them, or edit textual content whenever you want. On other 
types of image items, such as JPEG and Windows Bitmap files, 
annotations become a permanent part of the image when you save the 
item. For item types that cannot accept annotations, PaperPort 
automatically disables the annotation tools. 

Using PaperPort’s annotation tools, you can add notes and text, highlight 
text, draw lines and arrows, or stamp a picture onto an image item.

It is easy to send a document with annotations to people without PaperPort 
by using the PDF Image or PDF Searchable format. The recipient only has 
to double click on the e-mail attachment they receive from you and they 
will see the document in the system default PDF viewer – annotations 
intact.

Annotation tools
You can select an annotation tool from the Annotation ribbon whenever 
you display an image item in the Image View window. Use commands 
in the Annotation Settings group to change properties for future 
annotations created with that tool. 
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This does not affect existing annotations. To turn off any annotation 
tool, click a different one – the Select Annotation tool is usually the 
best for this. See a detailed list of these tools in Help. 

We detail here the annotation tools available in PDF Viewer Plus for use 
with PDF files.

Use the following commands in PDF Viewer Plus:

Hand 

Select this tool and click in an annotation to move, 
cut, copy, or resize it on the page. Double-click on 
a note or text box to edit its text. Right-click on a 
selected annotation to change its status or 
properties.

Note

Want to give yourself a reminder? Select the Note 
tool and add a resizable note much like a sticky 
note that you write on and then stick on paper 
documents. You can shrink the note to an icon. 
Right-click to access note properties. Double-click 
to re-open the note.

Text Box

Adding a text label to your images is simple with 
the Text tool. Select this tool to enter text whose 
properties you can set in Edit > Preferences > 
Comment.

Highlight
Use the Highlighter tool to highlight selected text 
on the page or in a text box, just as you might use a 
highlighting pen on paper.

Pencil
The Pencil tool lets you draw freehand lines  on 
the page.

Line 
Select Line tool to draw straight lines; right-click 
and choose properties to make arrows and further 
format the line. 

Stamp 
The Stamp tool lets you paste supplied stamps or 
bitmapped images of your choice on the page, 
much like using a rubber stamp.  
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Protecting Items
In PDF Viewer Plus you can adjust the security level of your 

PDF files (supported up to format 1.7) in the Document menu. When 
you create a new PDF from existing ones (for example, by copying a 
thumbnail of a page onto a Workspace or by duplicating a PDF item) its 
security settings will be the same as those of the original one. Newly 
created blank PDF files are generated without security settings, but these 
can be added after creation.

There are two types of passwords in the program. The open password 
restricts document accessibility: you can only open it by supplying the 
password when prompted. The permissions password allows users to 
open a protected document and define how the document may be used. 
If it is not specified, further use of the file is possible without any 
restrictions. 

Filing Items
A key to organizing items in PaperPort is filing items in 

appropriate folders. You can drag and drop items from one folder to 
another or from the PaperPort desktop into any folder you want. You can 
specify search criteria to help you find your items later. The name of 
each item appears below the thumbnail in thumbnail view. 

Using the Folder Manager dialog box, you can 
add, remove, move, and rename PaperPort 
folders. You can change the color of a folder 
icon to one that helps you organize your items. 
You may also add, remove, move, and rename 

any folder in Windows Explorer that is viewed with the PaperPort folder 
structure. These changes will be automatically reflected in PaperPort.

In the Folders pane, you can drag and drop, copy or move subfolders 
and their content to other subfolders or PaperPort folders, and create or 
delete subfolders Sharing and Security adjustments can also be directly 
made for each folder shortcut menu. 
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The Back button makes it easy to step through the ordered 
history of folders you recently visited one by one – functioning 
similarly to Internet Explorer – enhancing quick backward 
navigation for both Workspaces independently of each other.

Adding search criteria to items
You can add document information to any PaperPort item. 

Right-click the item and choose Properties. With PDF files or read-only 
MAX files you will see existing document information, if any. For other 
file types there is no display beyond the item name. Click the File 
Properties button and choose the Summary tab. Enter Title, Subject, 
Author, Keywords and Comments as desired. 

This information is stored not only in PaperPort but also in your system 
–  here it can be viewed and changed. Search facilities in your system 
may be able to access this data.The All-in-One Search in PaperPort 
functions only on document information entered into read-only MAX 
and PDF files. For read-only MAX files this information must be pre-
existing, it cannot be modified and new information cannot be added.

For PDF files, document information can be added in PDF Viewer Plus 
or PDF Converter Professional, using Document Properties in the 
Document menu. 

This is saved back to the file in PaperPort when you close PDF Viewer 
Plus or choose File > Save. It is not saved if you just switch back to the 
PaperPort desktop.

To add searchable document information to read-only MAX or XPS (or 
other) files, we recommend converting them to PDF and then adding it.

Finding Items

PaperPort provides features to help you find your PaperPort items. You 
can quickly find an item by visually browsing through thumbnails on 
your PaperPort desktop. 

When you have many folders and items, PaperPort provides more 
powerful capabilities with All-in-One Search. 
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Open the Properties pane to see the document information for PDF and 
read-only MAX files. This is the text that can be handled by the All-in-
One Search. To perform a search:

1.    Open the All-in-One Search panel.

2.     Decide whether to display only the file with first match or to list all 
files whose file information includes the searched text.

3.     Define the scope of the search: Current folder, Current folder 
with sub-folders or All PaperPort folders.

4.     Enter the search string in the Name, Author, keywords text box. 
Typically you will enter one word, but text fragments and multiple 
words are also possible (see below).

5.     Expand the panel  and use the checkmarks to exclude 
information fields, for example to search an author's name in that 
field only.

6.     Click Search.

If you chose to see only the first occurrence, the first found file 
containing the searched text is highlighted. Use Find Next in the Item 
ribbon to move to the next occurrence. If you chose to see all 
occurrences, a list of all matching items is displayed.

Search category choices:  

• Name: item name. This is not necessarily the file name; it is 
available for all items, as entered in the Properties pane or Item 
Properties dialog box in PaperPort. 

• Author: as defined in PDF Viewer Plus under Document 
Properties. 

• Keywords: as defined in PDF Viewer Plus with Document 
Properties. 

• Subject/Comments: as defined under ‘Subject’ in PDF Viewer 
Plus. 

• Annotations: Notes or text box content added to PDF or added to  
MAX files by previous versions of PaperPort.
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How searching works:

This searching ignores case, so 'dns' will find 'DNS' and 'paperport' will 
find 'PaperPort'. There is no whole word choice, so a search for 'ns' will 
stop on 'DNS' and 'for' will stop on 'information'. If you enter two or 
more words, each one is searched separately; all files that contain any of 
the given words will be found. To search a multi-word string as a single 
entity, enclose it in quotes, for example “results are”.

How search results are displayed:
When a search for all items is complete, results are displayed with each 
as one row of a table. Select one to see the searched file information 
above the listing. Click the View Text button to extract text from the 
selected item. Click the Copy Text button place this text onto the 
Clipboard. Right-click a result file and choose Open to launch the 
document in its associated application. Open Containing Folder 
switches to the file’s folder with the file selected.

Finding words in PDF content:
Searchable and Normal PDF files can be searched in PDF Viewer Plus. 
PaperPort can make searchable PDF files from PDF Image files or other 
image items. This enables other programs, such as Nuance PDF 
Converter, Windows Desktop Search or Google to search the contents of 
these files. See Creating PDF Documents on page 38.

Finding words in other files:
You can run the PaperPort OCR on image items, including read-only 
MAX, XPS and PDF Image with the View Text button in the Properties 
pane. You can copy this text to Clipboard and paste it into a word 
processor program so that it can be searched. A better solution is to use 
OmniPage if you have it – drag the item onto its icon on the Send To bar. 
The OCR result will be more accurate and the document formatting can 
be retained.
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Sharing Files
PaperPort provides many tools to make it easy for you to share files, 
images, and documents with friends, colleagues, and business 
associates.  

These tools are built into the program and are readily available on 
different ribbons for quick access whenever you need them.

 
To help you share your items with others, PaperPort makes it easy to:

E-mail items to others, simply by dragging the items to 
your favorite e-mail program on the PaperPort Send To bar.

Scan or convert items to the PDF format, the ever-popular 
file-sharing format considered by many as the industry 
standard for document distribution.

Access shared folders located on your local or wide area  
network, by adding the folders to your PaperPort Folder 
pane. 

Access Sharing and Security settings directly from the 
folder shortcut menu.  

Access a number of cloud services including Microsoft Live 
SkyDriveTM, GoogleDocsTM, Box.netTM, FTP sites, and 
many more.  
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With PaperPort, it is simple to set up a 
shared folder on a server,  web storage 
sites, or a PC that can act as a central 
repository for all important office 
documents. Each PaperPort client can 
connect to that folder and use 
PaperPort’s document management 
features and paper handling tools to 
find and use documents instantly.

In addition, you can convert items to popular output formats for shared use 
in numerous other programs. To obtain a list of all supported program links, 
visit PaperPort at the Nuance web site at http://www.nuance.com.

Connecting to the Cloud
PaperPort 14 introduces support for Cloud computing – accessing and 
working with web-based storage sites for programs, documents and data.

Nuance Cloud Connector 

This is a self-standing program delivered with all variants of PaperPort, 
whose installation is optional. When installed, it can be started from the 
Nuance Cloud Connector group in the Windows Start menu. It provides 
access to other popular storage sites in the Cloud, including Microsoft Live 
SkyDriveTM, GoogleDocsTM, Box.netTM, multiple FTP sites, and many 
more. Its interface lets you establish connections from your file system to 
and from chosen Cloud sites; it also manages passwords and login data.

Evernote Connector

This is a new connector inside PaperPort 14, appearing as an icon on the 
Send To bar. This allows files to be dragged onto the icon so their copies 
are transferred to the Evernote storage site. Send To options can be used to 
specify access data. 
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Sending Items to Other Programs

Drag and drop functionality makes opening your files in your favorite 
programs a snap. Simply choose the file you want and drop it onto the 
program icon on the Send To bar at the bottom of the PaperPort desktop.

Common office tasks like e-mailing and faxing are now faster than ever. 
The Send To bar makes using scanned documents in other applications 
easier by automatically translating the document into a form that the 
receiving application can understand. For example, you can drop a 
scanned image of a letter onto the Microsoft Word link on the PaperPort 
Send To bar, and PaperPort will recognize that the application you are 
attempting to open needs a text file rather than an image file. PaperPort 
will run OCR for you, and send editable text to Word rather than a static 
image file. 

PDF ConverterMicrosoft Outlook®OmniPage 

PDF Viewer Plus

PaperPort supports a wide variety of programs including word 
processing, spreadsheet, fax, Internet e-mail, graphics, optical character 
recognition (OCR), and online services programs. 

The program link on the Send To bar does any necessary conversion and 
may provide options for sending the item.

Use OmniPage with PaperPort

If PaperPort exists on a computer with OmniPage, its OCR services 
become available and amplify the power of PaperPort. 
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You can choose an OCR program by right-clicking on a text 
application's PaperPort link, selecting Send To Options and then 
selecting OmniPage as the OCR package, instead of the always 
available PaperPort OCR.  

With OmniPage you can:

• Instantly convert paper into usable Microsoft Office documents. 

• Turn PDF files into editable documents while retaining their layout. 

• Automatically process images from network MFPs and scanners. 

• Scan and convert documents into XML, PDF, TIFF and more. 

• Share documents using e-mail, Web, Cloud Connector, XML and  
e-Books.

• Use OmniPage workflows  for instant but effective control 
over document conversions.

Customize the Send To bar

You can change the way program icons appear on the Send To bar in a 
number of ways. Specifically, you can add programs, and remove or 
rearrange program icons. 

Refer to the PaperPort Help for details.
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Adjust Send To options

You can tune Send To options to 
specify how you want to use a 
certain program on the Send To bar. 
For example, you can specify the file 
format in which PaperPort will save 
an item.

  

To e-mail an item, simply drag and 
drop the item to your e-mail program 
on the Send To bar. Use the e-mail 
link options to specify the file format 
of the attachments and other options.

Converting Items 
Using PaperPort, you can convert scanned documents and text items to 
image formats, and convert images back to text. 

Convert items to image formats

You can convert scanned documents and text items to image formats.

• The Save As command allows you to save image items to any of a 
variety of standard image formats including PDF, JPEG, and TIFF.  
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• The Duplicate as PDF Item command allows you to convert text 
items to PDF Image items.  

By selecting more than one item, you can convert multiple items to a 
new format at the same time. Refer to Help for details.

Stacking documents

You can assemble a set of PDF files by stacking them into a single PDF. 
You can unstack the current page or all pages from a multi-page PDF file. 
When all pages are unstacked, the result is a set of single-page PDF files, 
uniquely identified by a set of numerical suffixes. When stacking and 
unstacking, the original PDF files or pages do not remain. To stack files, 
use drag-and-drop or select the desired files, right-click and choose Stack. 
Similarly, use a shortcut menu to unstack a PDF file. 

Combining documents

You can assemble documents by combining them. The files to be 
selected need to be in a single folder and selected in the order you want 
them in the stack. Click the arrow next to Combine Items and choose 
one of the available combinations:  

• Combine into PDF Stack: Each original page becomes one PDF 
page with no resizing.

• Combine into Multi-item PDF Pages, Resize to fit: This resizes 
the contributing items and always places four original pages onto a 
single PDF page.

• Combine into Multi-item PDF Pages, Maintain original sizes: 
This places as many original pages onto each PDF page as it can.

• Combine into Thumbnail PDF Page: This creates thumbnails of 
all item pages and fits as many as possible on a PDF page.

The original items remain in their original file types. 
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Convert images to text

You can convert scanned documents to text by a simple drag and drop of 
the thumbnail to your word processor program. PaperPort automatically 
processes your scanned document using PaperPort’s OCR software, 
launches your word processing program, and loads the scanned text into 
a document ready for editing. PaperPort also allows you to copy text 
from part of an image item for use in a text editing, word processing, or 
spreadsheet program. The OCR software processes the text and copies it 
to the Windows Clipboard. Open the program in which you want to 
insert the text, and use Paste to paste the text in a file.

Filling Forms
Active PDF forms can be filled using your PDF product. 
Choose the Hand tool and step through the form fields using 
Tab or arrow keys, making choices and entering texts. Help and 
the How-to-Guides list all the possible form control types.

After you enter data and complete the form, save the form to the 
PaperPort desktop so that you can print or e-mail the form in its entirety 
with its completed data.

If you have a pre-printed form, choose Form Fields Only in the Print 
dialog box to print your responses directly onto the form.

PDF File Support
PDF Flavors

PDF (Portable Document Format) files are often classified into 
three different types, commonly called flavors:

• PDF Image 
• PDF Searchable Image 
• PDF Formatted Text & Graphics (PDF Normal) 
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Opening PDF files

PaperPort can open and display PDF files of all three flavors. PDF files 
by default open in PDF Viewer Plus or (if available) in PDF Converter 
Professional. They can be opened as PDF Image in ImageViewer. 

Protected files can be accessed by giving the correct  password. Security 
limitations are respected and can be changed if you can provide the 
Permissions password.

PDF page operations

In PaperPort you can insert or append pages from one PDF file to 
another and also stack a set of PDF files into a single one. 

With pages of different flavors, the program determines a single flavor 
for the resulting file. You can unstack one or all pages from a multi-page 
PDF file to get one PDF per page.

Combining items into a PDF file

You can combine a wide range of image items into a single target PDF. 
All combined items remain in their original locations and file types. 

Annotating PDF files

You can add notes, highlights and graphic items like arrows to PDF 
pages of any flavor as annotations. These do not become part of the real 
PDF page, but exist on a separate layers so they can be viewed, moved, 
changed or deleted in PaperPort or other PDF viewing and editing 
programs. Annotation can be done in ImageViewer or your PDF 
product.

Modifying PDF files

Use SET tools to improve the appearance of PDF pages or prepare them 
for more successful text recognition (OCR). See page 25 and the Help 
topic: About enhancing pages and images. 

To modify the real text content in a PDF file, or change its color or 
attributes, you need a PDF editor such as Nuance PDF Converter.
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Extracting text from PDF files

The Copy Text command in a PDF file’s shortcut menu extracts the 
whole text and places it onto the Clipboard as plain text, running OCR if 
necessary. The command View Text in the Properties pane of a selected 
PDF file does the same, but displays the text in a PaperPort window. 
Select a block of text to copy it to Clipboard. Send PDF files to word 
processor programs on the Send To bar. This delivers editable text with a 
defined level of formatting, using OCR if necessary. See the Help 
topics: To convert scanned documents to text and Output options for the 
target program.

Adding document information to PDF files for searching

Do this in your Nuance PDF product. See the Help topics: Assigning 
properties to PaperPort Image and PDF files and Item properties. 

Saving PDF files to other file types

You can save PDF files to a range of image file types and to XPS files. 
See the Help topic: About Saving Image Items. A multi-page PDF results 
in a single file when a multi-page file type is selected, otherwise each 
PDF page becomes a separate file.

Adding PDF files to Windows Desktop Search

Go to Desktop > Options > Advanced to enable or disable PaperPort as 
the agent for handling PDF files in Windows Desktop Search.

For more information see the Help topics: About PDF files and About 
Creating PDF Files.

Creating PDF Documents

Create PDF Image files from other applications

In Desktop > Options > Items choose between PDF Image and PDF 
Searchable. Then open a source file in a suitable application and choose 
Print, typically from the File menu. Choose PaperPort Image Printer 
and make print settings, e.g. black-and-white versus color conversion. 
See the Help topics: About the PaperPort print driver and Printing to 
PDF from other applications.
PDF File Support           45



Create PDF Searchable files from scanning

Open a scanning profile and set the PDF file type in the Output panel or 
choose the supplied profile Color Searchable PDF Document. See the 
Help topic: Modifying Scan Profiles. Use the profile to generate PDF 
files.

Create a PDF from an existing PDF, XPS or image item

Right-click on a PDF file and choose Duplicate Item, Duplicate 
Current Page or Save As. The flavor of a source PDF is retained for the 
copy. Right-click on an image item and choose Duplicate as PDF or 
Save As. When you double-click an XPS file so that it opens in PDF 
Viewer Plus, a copy is automatically created as a PDF file, ready to be 
modified and saved.

Uninstalling PaperPort 
For a full uninstallation, three PaperPort components should be 
removed, one after the other, in any order. The components are 
PaperPort 14 SE, PaperPort Image Printer and PDF Viewer Plus. 
Removing only the image printer and/or the PDF Viewer will cause 
PaperPort to function incorrectly.

Other accompanying program that can be uninstalled or retained, 
independently of PaperPort is Nuance Cloud Connector.

To uninstall PaperPort and its key components:

1. Select Add or Remove Programs (or Programs and Features) from 
the Control Panel.

2. Select Nuance PaperPort 14.

3. Click Remove to uninstall the program.

4. Repeat this for the Image Printer and PDF Viewer Plus. 

5. A computer re-start is needed to complete the removal.
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are either registered trademarks or trademarks of Adobe Systems Incorporated in the 
United States and/or other countries. Google is a trademark of Google, Inc. WordPerfect is 
a trademark or registered trademark of Corel Corporation and/ or its subsidiaries in 
Canada, the United States and/or other countries. The Verity logo is a trademark or 
registered trademark of Verity, Inc. in the United States and/or other countries.
Outside In ® Viewer Technology © copyright 1998 Stellent Chicago, Inc. All rights 
reserved. The word verification, spelling and hyphenation portions of this product, as 
detailed in the legal section of the Help system, are based in part on Proximity Linguistic 
Technology from Franklin Electronic Publishers, Inc. All rights reserved. This product 
was developed using Kakadu software, and is based in part on the work of the Independent 
JPEG Group. This software is based in part on the Zlib Compression Library and the work 
of Colosseum Builders.

MSXML binary files.  Use of the software is subject to the conditions and disclaimers 
contained in the MSDN CODE GALLERY BINARY LICENSE available at http://
code.msdn.microsoft.com/MSXML/Project/License.aspx .

Microsoft: HD Photo 1.0 Use of the software is subject to the conditions and disclaimers 
contained in the Microsoft Corporation Technical Documentation License Agreement for 
the specification "HD Photo" available at http://msdn.microsoft.com/en-us/windows/
hardware/gg463400.aspx .

Microsoft CAPICOM 2 -  INSTALLATION AND USE RIGHTS.  You may install and use 
any number of copies of the software on your devices running validly licensed copies of 
Windows 2000, Windows XP, Windows Vista, or Windows Server 2003.

FreeType 2.3.1. The FreeType Project is copyright (c) 1996-2000 by David Turner, Robert 
Wilhelm, and Werner Lemberg.  All rights reserved except as specified in the license 
found at http://freetype.sourceforge.net/index2.html .

Zlib. Source code files for Zlib were obtained by LICENSOR from Jean-loup Gailly and 
Mark Adler at www.Zlib.net . Copyright (c) 1995-2010 Jean-loup Gailly and Mark Adler.  
Use of Zlib is subject to the conditions and disclaimers contained in the license available at 
http://www.zlib.net/zlib_license.html .

The Independent JPEG Group's software.  Copyright (c) 1991-1998 by Thomas G. Lane.  
Use of the Independent JPEG Group’s software is subject to the conditions and disclaimers 
contained in the license available at http://www.xstandard.com/1D1B6C13-7BB6-4FA8-
A1F9-EC1E32577D26/license-ijg.txt .
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JBIG2 license - Copyright (c) 1990, 1991, 1992, 1993 Cornell University.  All Rights 
Reserved.  Copyright (c) 1991, 1992 Xerox Corporation.  All Rights Reserved.  Use, 
reproduction, preparation of derivative works, and distribution of this software is 
permitted.  Any copy of this software or of any derivative work must include both the 
above copyright notices of Cornell University and Xerox Corporation and this paragraph.  
Any distribution of this software or derivative works must comply with all applicable 
United States export control laws.  This software is made available AS IS, and XEROX 
CORPORATION DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND 
NOTWITHSTANDING ANY OTHER PROVISION CONTAINED HEREIN, ANY 
LIABILITY FOR DAMAGES RESULTING FROM THE SOFTWARE OR ITS USE IS 
EXPRESSLY DISCLAIMED, WHETHER ARISING IN CONTRACT, TORT 
(INCLUDING NEGLIGENCE) OR STRICT LIABILITY, EVEN IF XEROX 
CORPORATION IS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Contributing Authors Group - Copyright (c) 1995 Alexander Lehmann.  This software is 
provided 'as-is', without any express or implied warranty. In no event will the authors be 
held liable for any damages arising from the use of this software.  Permission is granted to 
anyone to use this software for any purpose, including commercial applications (see 
below), and to alter it and redistribute it freely, subject to the following restrictions:
          1. The origin of this software must not be misrepresented; you must not claim that 
you wrote the original software. If you use this software in a product, an acknowledgment 
in the product documentation would be appreciated but is not required.
          2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software.
          3. This notice may not be removed or altered from any source distribution.
           4. Binary only distributions of the software must include the file README with the 
copyright statement. You are welcome to add a copyright statement for your modifications 
and a contact address, though.

Apache Components.  Copyright (c) 1999-2003. The Apache Software Foundation.  All 
rights reserved.  The following names may not be used to endorse or promote products 
derived from the Apache licensed software without prior written permission:  Apache 
Cocoon, Apache Software Foundation, Ant, Jakarta, Apache Avalon, Avalon Excalibur, 
Avalon Framework, Batik, The Jakarta Project, Commons, FOP, Apache POI, Jakarta-
Regexp, Log4j, LogKit, Apache Lucene, Xalan, Tomcat, Struts, Velocity, Xerces, Axis, 
Jakarta-Oro, xml-commons, and WSIF.  Products derived from this software may not be 
called “Apache”, nor may “Apache” appear in the product name, without prior written 
permission.  Software is further subject to the conditions and disclaimers listed in Apache 
Software License v.1.1. found at http://www.apache.org .

Javascript Engine.  Source code files for Mozilla's FireFox Browser contained in the 
Javascript Engine were obtained by LICENSOR from Mozilla.org.  Such source code files 
have not been modified by LICENSOR.  Use of the Javascript Engine by LICENSEE is 
subject to the conditions and disclaimers in the Mozilla Public License, Version 1.1 found 
at http://www.mozilla.org/MPL/MPL-1.1.html .
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LCMS.  Marti Maria.  Additional information is available at http://www.littlecms.com .  
Use of this software is subject to the conditions and disclaimers contained in the license 
available at http://www.opensource.org/licenses/mit-license.php . 

Mozilla Public License.  Subject to the Mozilla Public License Version 1.1 (the 
“License”); these files may not be used except in compliance with the License.  Javascript 
Engine.  Source code files for Mozilla's FireFox Browser contained in the Javascript 
Engine were obtained by LICENSOR from Mozilla.org. Such source code files have not 
been modified by LICENSOR.  Use of the Javascript Engine by LICENSEE is subject to 
the conditions and disclaimers in the Mozilla Public License, Version 1.1 found at http://
www.mozilla.org/MPL/MPL-1.1.html .  

Copyright notice for the Evernote component
Copyright (c) 2007-2009 by Evernote Corporation, All rights reserved.
Use of the source code and binary libraries included in this package is permitted under the 
following terms: Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE.

All other trademarks referenced herein are the property of their respective owners.
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